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Embedded systems
From Wikipedia: An embedded system is a computer system—a 
combination of a computer processor, computer memory, and input/
output peripheral devices—that has a dedicated function within a larger 
mechanical or electronic system. Embedded systems control many 
devices in common use today. Ninety-eight percent of all 
microprocessors are manufactured components of embedded systems.

• Limited computation power 
and memory 

• Low power 

• Small size 

• Rugged operating range 

• Low cost

• cell phones 

• smart watches 

• appliances 

• automotive / avionics 

• cameras and photography 

• HVAC systems 

• factory automation 

• Internet of Things
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Microcontroller
A microcontroller is a one-chip computer.  In a single package, it has 
the computing core and memory (of various types) needed to store and 
run small programs.  There will be connections for power (obviously) 
and a serial communications channel for moving program information 
onto the controller and receiving information from the program. 

In addition a microcontroller has a number of other input and output 
connections. 

• Digital inputs from external sources.  These will detect whether the 
voltage on the input is “high” or “low”, which correspond to logic 
level 1 and logic level 0. The low voltage is usually 0 V and the high 
either 3.3 V or 5 V, depending on the particular controller. 

• Digital outputs that drive external components.  These can be set to 
either a high or low voltage to activate (or de-activate) components 
attached to the output. 

• Analog inputs that measure the measure voltage of a component 
attached to the input.  The voltage must be between 0 and 5 V, 
typically.
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Microcontroller
Other connections 

• Analog outputs produce an analog voltage that can be applied to an 
external component. (Not all controllers have these.)   

• Pulse-width modulation (PWM) produces a high/low square-wave 
signal where the ratio of the high time to the low time can be varied.  
PWM is usually produced by digital output pin.  PWM can be used 
as a “fake” analog output for controllers that do not have real analog 
outputs. 

Many of the pins are multi-purpose and can configured to do different 
jobs. For example, a digital pin can be configured to be either an input 
or an output.  The analog input pins can also be set up to work in a 
digital fashion if needed. 

These various input / output connections provide an interface between 
the digital core and the outside world, allowing for measurement of 
external effects and allowing for the microcontroller to make changes in 
response to external stimuli.
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Analog vs. Digital
A key concept in beginning to design and use microcontrollers in 
embedded systems is understanding the difference between analog and 
digital signals. 

Analog - a continuously varying energy or quantity of material.  Much of 
how we interact with the surrounding physical world is analog in nature 
– sound, sight, smell, taste.  We use sensors to convert physical analog 
quantities to analog voltages or currents.  (Microphones, photosensors, 
temperature sensors, etc.)  Just like the physical quantity, the voltage or 
current is defined at every point in time.  Detecting an analog voltage or 
current requires requires precisely measuring the volts or amps at a 
particular time.  A simple example of an analog signal is a sine wave. 
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Digital - The signal is either high or low (on/off or true/false or 0 /1).  
There are not many digital signals in the physical world.  However, in 
terms of encoding information into signals, digital is much more robust.  
There is more leeway in interpreting whether a voltage is high or low.  
“High” means simply being “high enough” — above some threshold 
level. “Low” means simply being “low enough” — below some 
threshold level.  Interpreting the information from a digital signal is less 
susceptible to errors because the voltages don’t have to be known 
precisely. 

The systems that we have developed to collect, manipulate, and 
transmit information work best by collecting the analog information 
from the surrounding physical environment, converting it digital form, 
processing the information digitally, and then converting back to analog 
(if needed).



Gary Tuttle — Arduino Club — 2023 Intro to Arduino – 6

Sensors
A key part of many embedded systems is measuring the surrounding 
environment.  Sensors provide this type of input.  There are many 
different kinds of sensors for measuring: 

• voltage, current 

• temperature (electronic, thermocouple, thermistor) 

• humidity / pressure 

• sound (microphone) 

• light (photoresistor, photodiode, bolometer) 

• distance (sonar, radar, lidar) 

• mechanical motion (accelerometer, gyroscope) 

• magnetic fields (coil, Hall-effect) 

• chemical 

• RFID tags



Gary Tuttle — Arduino Club — 2023 Intro to Arduino – 7

A bit of history
• Microchip was the original microcontroller company.  The first 

controller was the PIC1650 in 1976. The company at that time was 
called General Instruments. Microchip was spun out as a separate 
company in the late 1980s. PIC originally stood for Peripheral 
Instrumentation Controller. Microchip sells more than 1 billion 
microcontrollers per year. 

• Atmel was founded in 1984, specifically to compete in the 
microcontroller market. Their major product line is the AVR family of 
controllers. Atmel found gained lots of followers because it’s chip 
were used in Arduino. Recently, Atmel was bought by Microchip. 

• Texas Instruments (TI) is one of the original electronics companies. TI 
engineer Jack Kilby was one of the co-inventors of the integrated 
circuit. The MSP430 is one of their primary microcontroller products. 

• Many other companies 

ARM is separate microcontroller architecture owned by ARM Holdings 
(from Great Britain) that is licensed by many companies. It is used in all 
smartphones and finds increasing use elsewhere.
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Microcontrollers
There are literally hundreds of microcontrollers available from the 
various companies.  The differ on the number of bits (8, 16, 32, 64), 
memory (a few kilobytes to 1 gigabyte), clock speed (10s of kilohertz to 
1 gigahertz), price (a few cents to 10s of dollars) and the number of 
inputs and outputs (3 or 4 up to 100 or more). 

Start with 1 example - the Atmega328 from Atmel. (Used in Arduino 
Uno.) 

• 8-bit AVR architecture 

• 8 – 20 MHz clock frequency (16 MHz is typical) 

• 32 kbytes of flash memory (program storage) 

• 2 kbytes of static memory 

• 28-pin or 32-pin package 

• 14 digital I/O 

• 6 analog input (no analog out) 

• 6 PWM outputs (part of the 14 digital I/0)
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Note: Atmega328 has same pin configuration as Atmega 168.

Pin assignment for Atmega 168/328
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Developing embedded sytstems
What used to be needed to get started?  (In the “old” days.) 

• To make the hardware operational, the controller chip will need: a 
power supply, a clock oscillator crystal, a serial communications 
connection, and physical connections for all of the digital and 
analog pins.  Typically, this is provided by a prototyping platform 
available from the microcontroller supplier.  Of course, developers 
can also build their own prototype hardware, but this is usually not 
an effective use of resources. 

• Integrated Development Environment (IDE).  Software for the 
controller must be written on a regular computer (Windows/MacOS/
Linux) and then transferred to the controller.  Typically, the IDE is not 
particularly user friendly — some prior software experience is 
probably needed. Also, a special hardware dongle (a programmer) is 
needed for the transfer. 

Upshot: Developing embedded systems is only for “professionals”. 
Hobbyists or “makers” need not apply.
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Enter Arduino
In 2005, a group at the Interactive Design Institute Ivrea in Ivrea, Italy 
put together a hardware / software platform that would make it much 
easier to build embedded systems prototypes. (The titular leader of the 
group was — and still is — Massimo Banzi, although there were four 
other founders.) They named the platform Arduino, after a bar that they 
frequented. They were focusing on making a system on which students 
and hobbyists could learn easily and would be affordable to non-
professionals.  Their efforts unleashed the current “maker” movement. 

There have been several iterations on the basic platform over the years.  
The current standard hardware arrangement is the Arduino Uno.
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Arduino Uno hardware

Atmega 328 
(socketed)power (9 V 

battery + 5 V 
regulator)

oscillator 
crystal

I/O connectors

I/O connectors

USB

reset

blinky 
LEDs

ICSP

12

3.3-V 
regulator

Also power and ground connections. 
Can power 5-V and 3.3-V peripherals.
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Hardware expansion through “shields”

Ethernet WiFi Bluetooth

Touch display Motor
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Arduino Uno software
• The IDE for the Arduino is a Java application (runs identically on 

Windows / Mac / Linux). 

• The programs (called sketches) are written in a subset of C.  (Good for 
us!)  There some special commands for defining the operation of I/O 
and for receiving/sending information to those pins. 

• There is a USB interface to facilitate transferring programs from the IDE 
on the computer to the controller.  (No hardware dongle!)  The USB 
interface also conveniently provides power when connected to a 
computer. 

• There is an interface analogous to the console for sending information 
and receiving information from the controller. (serial monitor) 

• Note: The controller is meant to operate in a stand-alone mode.  It is 
not intended to be tethered to the host computer indefinitely.  But 
when developing the software, it is important to be able to “see” what 
is happening with the program. 

• Everything is open-source. (Including the hardware design.)



Gary Tuttle — Arduino Club — 2023 Intro to Arduino – 15

What is needed to get started?
An Arduino Uno board  ~ $27

Get it directly from Arduino 
(https://arduino.cc). Or from 
many familiar vendors: Amazon, 
Digikey, Mouser, Newark, 
Adafruit, Jameco. 

(Beware of knock-offs.)

USB - A to B cable
(Standard printer connection.)

Download and install the Arduino IDE

https://www.arduino.cc/en/Main/Software (Currently at ver. 2.04.)

https://arduino.cc
https://www.arduino.cc/en/Main/Software
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Structure of an Arduino program
An Arduino program (known as a “sketch”) is slightly different from our 
typical C program. There is no main function. Instead there are two 
separate functions — one called setup() and a second called loop(). 
Setup runs once at the beginning of execution and then loop() starts and 
runs in a continuous loop. 

• The setup function behaves just like a regular C program.  Program 
flow starts at the top and progresses through to the last line.  (If there 
are any loops with setup, they behave according to the conditionals 
like we would expect.)  As the name implies, the purpose of setup is 
to define variables, set the function of the pins, and take care of any 
preliminary housekeeping.  When setup() is complete, program flow 
passes to loop(). 

• The program continues with the first line of loop and then progresses 
through to the last line.  But, as the name implies, the program goes 
back to the first line of loop and runs again. And again and again.  
Forever.  (Or until the power is removed.)  It is as if there is an 
implied while loop whose conditional is always true.
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Getting started with a simple sketch
1. Download the Arduino IDE and install it on your computer. 

2. Connect the Arduino board to your computer with the USB cable. 

3. Launch Arduino IDE. A blank program template window appears. 
Empty versions of the two basic functions are in place. A line at the 
bottom of the window indicates that the board is not yet connected.
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4. From the drop-down menu at the top of the window, choose “Arduino 
Uno”. “/dev/cu.usbmodemxxxx” indicates that the connection will be 
made through the USB port. (This is USB name for a Mac connection 
— the number may be different on different computers. A Windows 
computer may have a COM port.) The The board and port selection 
can also be done using the “Tools” menu.
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5. After making the board selection, the status line at the bottom of the 
window indicates that an Arduino Uno is connected via the USB port. 
We are ready to roll.

If the message still indicates that no board is connected, check the USB 
connection and trying selecting the board and port using the Tools menu.
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6. A good way to start is to use some of the built-in programs. My 
favorite is “Blink” which simply blinks an LED on and off. It’s very 
simple and has all the basics of an Arduino sketch. 
From the file menu, select File→Examples→01.Basics→Blink. A new 
window opens with the Blink sketch.
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6. There are many lines of comments. We should read through those. 
But simplify presentation here, we show the sketch with most of the 
comments removed.

7. In the setup function, there is only one line: 
pinMode(LED_BUILTIN, OUTPUT); 
 
LED_BUILTIN is a pre-defined constant equal to 13. On the board, 
there is dedicated LED connected to digital pin 13. The pinMode 
command set pin 13 to be a digital output.
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8. In the loop function, there are two different commands. 
 
digitalWrite( LED_BUILTIN, HIGH) sets the output of the 
LED_BUILTIN digital pin (#13) to the high state, meaning 5 V. This 
will turn the LED on. digitalWrite( LED_BUILTIN, LOW) sets the 
output of pin 13 to digital, meaning 0 V. The LED turns off. 
 
delay(1000) means to do nothing for 1000 ms ( = 1 s). The controller 
go into a useless while loop for the prescribed time.
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8. The while loop has the following actions: 
Turn on the LED 
Wait 1 second 
Turn off the LED 
Wait 1 second 
Repeat ad infinitum. 
 
That’s it — the LED blinks.
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9. Upload the sketch to the Arduino by clicking the right-arrow button at 
the top left of the window. It takes a couple of seconds to upload. The 
lower portion of the sketch window changes to display some 
commentary relating to the transfer of the program. If there were any 
errors in the compiling or transferring the code, those will be reported 
here. We also see some LEDs on the board blink as the code is 
transferred.



Gary Tuttle — Arduino Club — 2023 Intro to Arduino – 25

9. As soon as the code is completely transferred, the program will begin 
running on the board. There is a small yellow LED off to one side that 
will start blinking — 1 second on, 1 second off. That’s the entirety of 
the exercise.
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10. Play around with program by making some changes: 
- Substitute the number 13 for BUILTIN_LED in each line 
- Change the on and off times. 
- Add more lines to change the blink pattern. 
- Connect and external LED/limiting resistor combination to pin 13 
   so that two LEDs will blink. 
- Connect the external LED/resistor combination to other digital pins 
   and make the corresponding changes the code. 
 
Note that after each change, the program will have to uploaded 
again from the computer to the Arduino board. 
 
With five minutes of playing around, we will understand everything 
about this simple program and a lot about how Arduino sketches 
work in general. 
 
We are off to a good start towards learning about embedded 
systems, but there are many more fun things to learn.


